What is the Relationship Between Water Hardness and Conductivity?

Introduction:
Scientists often learn about the quality of stream water and how a stream changes by collecting data from the stream water over an extended period of time. This data is then analyzed. Scientists will look for patterns or trends in the data and attempt to devise an explanation for any observed trend(s). From the data, scientists can then answer questions regarding the health of the stream. Is the water suitable for agricultural use or as a local water supply? Is the water capable of sustaining a diverse population of organisms? Is stream health deteriorating, and does the stream need to be treated before further degradation occurs?

In this particular activity, you will be examining a set of data that comes from a stream observatory in Puerto Rico. As part of a nationwide program known as the Critical Zone Observatory, or CZO, this site is just one of several that has served as a natural laboratory for scientists and researchers to better understand how the earth processes between rock, water, and the atmosphere influence one another.

The data you work with in this activity comes from a study conducted on the Mameyes River in Puerto Rico. The specific location is referred to as Puente Roto. For several years scientists have been gathering data along this river to better understand how it interacts with the surrounding geology and atmosphere. An image of the river and reference map is shown below.

The two variables examined in this activity are:

- specific conductance
- water hardness

For Your Reference:
Specific conductance is a measurement of water’s ability to conduct an electric current. It is most often dictated by the amount of dissolved solids (ions) present in the water. The common unit of measurement for specific conductance is microsiemens per centimeter (µS/cm).

Water hardness is a measurement of the amount of dissolved ions, specifically calcium (Ca²⁺) and magnesium (Mg²⁺), in a sample of water. The common unit of measurement for dissolved ion concentration is milligrams per liter (mg/L). Note: 1 mg/L is equivalent to 1 part per million (ppm).
Task #1:
Form a hypothesis. Predict how you think these two variables are related.

_____________________________________________________________________________________

Task #2:

- Access Mr. Thomas’ Radnor High School webpage to obtain the data needed for this analysis.
- Click on Advanced Chemistry.
- Click the link to the Excel file titled “Luquillo CZO Data Analysis Activity: Specific Conductance and Water Hardness.”
- Select the tab titled “All Data 2005.”
- Answer the two questions related to the data below.

1. How frequently was data collected at this location? ________________________________

2. What was the total length of time which data was collected? ________________________

Task #3:
Create an x-y scatterplot graph with specific conductance on the y-axis and magnesium ion concentration on the x-axis. To do this...

- Select the data values for magnesium ion (Mg^{2+}) concentration (cells C3-C54) by clicking and dragging.
- While holding the control key, select the data values for specific conductance (cells E3-E54), again by clicking and dragging. At this point, both columns should be a shade of gray.
- Click on the Insert tab.
- Under charts, click on “Scatter” and select the first option – Scatter with only markers
- Right click on any data point. Select “Add Trendline.” In the window that pops up, check off the box for “Display R-squared value on chart.” Then click close.
- Using the Y vs X format, give the graph a title. This can be done by selecting the Layout tab under chart tools. Note: If you clicked off the graph, this feature will not be available. Be sure your graph is selected by clicking on it if need be.
- Again under the Layout tab, label the x and y axes with appropriate title and unit.

Task #4: Graph Analysis
Answer the following questions regarding the graph.

1. Describe the relationship between magnesium ion concentration and specific conductance. Hint: Is this a direct or indirect relationship?

_____________________________________________________________________________________

2. Looking at the graph, can you make a prediction as to how a change in magnesium ion concentration would affect specific conductance? For example, if ion concentration is doubled, would specific conductance also double?

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________
3. Based on the pattern identified in question #3, if magnesium ion concentration rose to 4 mg/L, what approximate conductance value would be expected?

4. Examine the data points on the graph. Do any appear to be inconsistent with the general trend/pattern? In other words, do any data points appear to “not fit?” If so, indicate the date of the identified data point(s).

5. Remove the date(s) identified in question 4 from your Excel spreadsheet. Do this by deleting the Mg\(^{2+}\) value for the date(s) identified. How does the removal of these data affect the R\(^2\) value?

6. Removing data from a graph in order to obtain more desirable results is not “good science.” Propose an alternative plan for dealing with the data that does not seem to fit.

**Task #5: Extension Activities**

1. Similar to the first graph created, create a second scatterplot graph that plots specific conductance on the y-axis and calcium ion (Ca\(^{2+}\)) concentration on the x-axis. Include all appropriate labels. Identify any similarities and/or differences between the two graphs.

2. Investigate specific conductance against calcium and magnesium ion concentrations for the years 2004 and 2003 by creating similar scatterplot graphs. Identify similarities and differences from one year to another.

**Task #6: Extension Questions**
Visit the USGS website on water hardness at [http://water.usgs.gov/owq/hardness-alkalinity.html](http://water.usgs.gov/owq/hardness-alkalinity.html)

1. According to the USGS, what concentration of calcium ion as calcium carbonate classifies water as “soft?” What calcium ion concentration classifies water as “hard?”

2. Based on the 2005 data, is the water of the Mameyes River considered soft, hard, or somewhere in between?
3. What are some of the common problems associated with hard water?

__________________________________________________________________________________

__________________________________________________________________________________

4. If you lived in an area with very hard water, what might be done to correct the problem? _______

__________________________________________________________________________________
What is the Relationship Between Water Hardness and Conductivity?

Introduction:
Scientists often learn about the quality of stream water and how a stream changes by collecting data from the stream water over an extended period of time. This data is then analyzed. Scientists will look for patterns or trends in the data and attempt to devise an explanation for any observed trend(s). From the data, scientists can then answer questions regarding the health of the stream. Is the water suitable for agricultural use or as a local water supply? Is the water capable of sustaining a diverse population of organisms? Is stream health deteriorating, and does the stream need to be treated before further degradation occurs?

In this particular activity, you will be examining a set of data that comes from a stream observatory in Puerto Rico. As part of a nationwide program known as the Critical Zone Observatory, or CZO, this site is just one of several that has served as a natural laboratory for scientists and researchers to better understand how the earth processes between rock, water, and the atmosphere influence one another.

The data you work with in this activity comes from a study conducted on the Mameyes River in Puerto Rico. The specific location is referred to as Puente Roto. For several years scientists have been gathering data along this river to better understand how it interacts with the surrounding geology and atmosphere. An image of the river and reference map is shown below.

The two variables examined in this activity are:

- specific conductance
- water hardness

For Your Reference:
Specific conductance is a measurement of water’s ability to conduct an electric current. It is most often dictated by the amount of dissolved solids (ions) present in the water. The common unit of measurement for specific conductance is microsiemens per centimeter (µS/cm).

Water hardness is a measurement of the amount of dissolved ions, specifically calcium (Ca²⁺) and magnesium (Mg²⁺), in a sample of water. The common unit of measurement for dissolved ion concentration is milligrams per liter (mg/L). Note: 1 mg/L is equivalent to 1 part per million (ppm).
Task #1:
Form a hypothesis. Predict how you think these two variables are related.

__________________________________________________________________________________

__________________________________________________________________________________

Task #2:
• Access Mr. Thomas’ Radnor High School webpage to obtain the data needed for this analysis.
• Click on Honors Chemistry.
• Click the link to the Excel file titled “Luquillo CZO Data Analysis Activity: Specific Conductance and Water Hardness.”
• Select the tab titled “All Data 2005.”
• Answer the two questions related to the data below.
  1. How frequently was data collected at this location? _________________________________
  2. What was the total length of time which data was collected? ________________________

Task #3:
• Create an x-y scatterplot graph with specific conductance on the y-axis and magnesium ion concentration on the x-axis.
• Add a linear trendline to the data and display the R² value on the chart.
• Label all axes appropriately and title the chart.

Task #4:
Answer the following questions regarding the graph.

  1. Describe the relationship between magnesium ion concentration and specific conductance. ____________________________________________________________

  2. Does your answer to question 1 support your hypothesis stated in task #1? ______________________________

  3. Looking at the graph, can you make a prediction as to how a change in magnesium ion concentration would affect specific conductance? For example, if ion concentration is doubled, would specific conductance also double?

  4. Based on the pattern identified in question #3, if magnesium ion concentration rose to 4 mg/L, what approximate conductance value would be expected?
5. Examine the data points on the graph. Do any appear to be inconsistent with the general trend/pattern? In other words, do any data points appear to “not fit?” If so, indicate the date of the identified data point(s).

__________________________________________________________________________________
__________________________________________________________________________________

6. Remove the date(s) identified in question 5 from your Excel spreadsheet. How does the removal of these data affect the $R^2$ value?

__________________________________________________________________________________
__________________________________________________________________________________

7. Removing data from a graph in order to obtain more desirable results is not “good science.” Propose an alternative plan for dealing with the data that does not seem to fit.

__________________________________________________________________________________
__________________________________________________________________________________
__________________________________________________________________________________

Task #5: Extension Activities

1. Similar to the first graph created, create a second scatterplot graph that plots specific conductance on the y-axis and calcium ion concentration on the x-axis. Include all appropriate labels. Identify any similarities and/or differences between the two graphs.

2. Investigate specific conductance against calcium and magnesium ion concentrations for the years 2004 and 2003 by creating similar scatterplot graphs. Identify similarities and differences from one year to another.

Task #6: Extension Questions
Visit the USGS website on water hardness at http://water.usgs.gov/owq/hardness-alkalinity.html

1. According to the USGS, what concentration of calcium ion as calcium carbonate classifies water as “soft?” What calcium ion concentration classifies water as “hard?”

__________________________________________________________________________________

2. Based on the 2005 data, is the water of the Mameyes River considered soft, hard, or somewhere in between?

__________________________________________________________________________________

3. What are some of the common problems associated with hard water?

__________________________________________________________________________________
__________________________________________________________________________________
4. If you lived in an area with very hard water, what might be done to correct the problem? ________